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Introduction

The Mortgage Director LOS interface for Radian mortgage insurance (MI) enables end-users to 
request mortgage insurance quotes, order a mortgage insurance certificate, or re-issue an 
existing certificate for borrowers and have that information automatically applied to the loan 
record.

The information in this document guides LOS end-users through the process of setting up and  
using various features of the Radian mortgage insurance (MI) Interface.

Interface Features
The Radian Mortgage Insurance interface has the following features:
•	 End-users can request quotes, order MI certificates, and resubmit or re-order quotes 

or certificates
•	 Support for monthly deferred insurance
•	 The loan Conversation Log is updated for tracking and recording certain request and 

response activities, such as rate quotes and certificates.

Interface Requirements
Before setting up and enabling the interface, you will need the following:
•	 Valid lender account with Radian
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Interface Considerations
The following should be considered when implementing this interface:
•	 Certificates cannot be cancelled through the interface.
•	 Radian does not have a separate credit union subsidiary; the Master Policy number sent through 

the LOS interface is used to determine if the lender submitting a request is a credit union.
•	 Rate quote responses from Radian do not include assessment or taxes for subject 

properties in FL, KY, WV.
•	 Radian only supports shared lender-wide credentials; it does not support individual user 

credentials (employee, contact, or company).
•	 Radian interface does not support the termination or cancellation of existing MI certificates 

or applications from within the LOS; users should contact Radian Customer Care at 
877-Radian1 (877.723.4261) or customercare@radian.com for assistance.

How Does It Work?
This section provides a summary flow description of the general LOS interface setup and 
usage processes, as they apply to Mortgage Insurance (MI) services.

Interface Setup
Note: The following process is typically followed by a customer’s LOS administrator, 
with the assistance of Mortgage Director Implementation or Support staff.

1.	 LOS customer contracts service with the interface vendor and receives the necessary 
information for setup and configuration in the LOS (such as credentials and URL links 
for requests).

2.	 Mortgage Director enables access to the interface for the LOS customer using Feature 
Control.

	� Note: This typically requires a separate interface agreement from the customer with 
Mortgage Director and the interface vendor.

3.	 LOS customer administrator configures the following items for the enabled interface:
a.	General settings and lender credentials on the Setup screen.
b.	System and Loan Privilege Security Bundles.

Interface Usage
1.	 LOS end-user (user) starts the LOS and creates a new loan or opens an existing one.
2.	 To request a MI Rate Quote, the user accesses the Mortgage Insurance Edit screen 

from the Mortgage Data or Qualification screen.
3.	 To order a MI Certificate and view responses, the user accesses the Export to <vendor> 

screen from the Interfaces > Mortgage Insurance item on the Loan Overview.
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LOS Administrator – Interface Setup

Note: This section is for LOS system administrators who are responsible for setting up and 
configuring interface settings, including security.

The Radian MI interface is configured from the Interfaces Setup to enable visibility of the 
interface for LOS end-users.

Enable Interface
Path: Loan Ledger > File > Background > Interfaces > Radian
	 Radian Setup
To enable the interface:
1.	 Open the Radian Setup screen.
2.	 Select the Enable Radian 

Interface checkbox.
When selected, users with proper 
security rights can access the 
interfaces from the Interfaces 
menu and select the on the 
Loan Overview.

3.	 Enter the interface credentials:
•	 Master Account ID – master account identifier (assigned by Radian)
•	 Password – account password (supplied by Radian)
•	 Lender ID – identification number (supplied by Radian)
•	 URL – enter or select the URL used to send request for MI certificate  

(for testing or production), supplied by Mortgage Director
•	 Rate Quote URL – enter or select the URL used to send interface  

Rate Quote requests (for testing or production), supplied by Mortgage Director

4.	 Click OK.

Security
Access to the Radian interface is controlled by LOS security and configured in both 
System and Loan Privilege Bundles.
Path: Loan Ledger > File > Background > Security > Security Levels
	 Security Setup Screen

System Privilege Security
These security settings control 
whether LOS administrators or  
end-users can view or modify the 
interface Setup screen item from 
the Loan Ledger (File > Background 
> Interfaces > ‘vendor’).
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To configure the interface security for system privilege bundles:
	� Interface Security Setup  

(System Privilege Bundle Details)
1.	 Open the Security Setup screen, and then click 

System Privilege Bundles.
2.	 Double-click the bundle you want to configure.
3.	 Scroll to Background, and then select Interfaces.
4.	 Locate the Radian listing.
5.	 Set the security rights within the selected bundle 

using the available check boxes:
•	 No Access – when selected, users cannot 

access or view the interface Setup screen.
•	 Read Only – when selected, users can access 

the interface Setup screen but cannot modify 
any of the field values or selections.

•	 Edit – when selected, users can access and modify items on the interface Setup screen.
Note: If none of these check boxes is selected, the LOS acts as if all options are selected.
Tip: Click on a setting option to select it and then click again to de-select it.

6.	 Save the changes and exit the screen.

Loan Privilege Security
These security settings control whether LOS end-users can access the interface from the 
Loan Overview to make requests, import results, or view status (Interfaces > ‘vendor’).
Note: The Mortgage Director LOS does not support different company or vendor-specific 
security for mortgage insurance at the loan level. The loan privilege security settings are the 
same for all mortgage insurance vendors that have been enabled for the customer.

	 Interface Security Setup (Loan Privilege Bundle Details) 
To configure mortgage insurance 
security for loan privilege bundles:
1.	 Open the Security Setup screen, 

and then click Loan Privilege 
Bundles.

2.	 Double-click the bundle you want 
to configure.

3.	 Scroll to Interfaces, and then 
select Mortgage Insurance.

4.	 Set the security rights within the selected bundle using the available check boxes:
•	 No Access – when selected, end-users cannot access interface screens.
•	 Read Only – when selected, end-users can access interface screens and features 

but cannot modify or enter values in any of the available fields.
•	 Edit – when selected, end-users can access and modify interface screens and features.
•	 Export – when selected, end-users can export interface results from the LOS.
Note: If none of these check boxes is selected, the LOS acts as if all options are selected.

5.	 Save the changes and exit the screen.
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LOS End-User

Note: User access to the main interface screen is based on individual security rights. 
If a user does not have access to a section or feature, they should contact their LOS 
system administrator.

Requesting an MI Quote
The Mortgage Insurance Edit screen is the primary screen used to 

Path: Loan Overview > Mortgage Data or 
Qualification screen > Mortgage Insurance 
field (…)
To request a Mortgage Insurance quote 
from Radian:
1.	 Create new loan or open an existing one.
2.	 Open the Mortgage Data or 

Qualification screen.
3.	 Click on the Mortgage Insurance field, 

and then click the lookup button .

This opens the Mortgage Insurance 
Quote screen.
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4.	 Click Rate Quote Request.
This opens the Rate Quote screen.

5.	 Select an MI Vendor from the list.

	 MI Rate Quote Data Check 
6.	 Perform a data check to make sure  

the required loan data is complete before  
making the interface service request.
Note: It is recommended to perform a data check 
to reduce the chance of errors during request 
processing and to ensure that the current loan 
meets minimum data requirements.

Reminder: The toolbar check mark color indicates the data check status.  
(Fail = Red, Warning = Yellow, Pass = Green).

To perform a data check on a loan before submitting a request through the interface:
a.	Click the data check button.
b.	Clear any ‘Failure’ and review ‘Warning’ items, using the provided data check item links 

to access the screens or fields that need adjustment.
c.	 Save any changes.

7.	 Complete the remaining data input fields.

Tip: Click on a field to view descriptive 
help text at the bottom of the window.

8.	 When you are finished, click Send Rate Quote Request.
This packages the current loan information and MI quote request data and transmits 
the request to the interface vendor for review and processing.
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9.	 Review the Rate Quote Confirmation  
after the request has been processed.

10.	Click Import to import the rate quote 
information to the loan record. 
Note: This action also updates and 
populates the Mortgage Insurance Edit 
screen with the returned request values.

 

11.	Save any changes.
The quoted MI rate information appears as 
a calculated result (gray background) in the 
Mortgage Insurance field on the Mortgage 
Data and Qualification screens.

Locking Mortgage Insurance Quote
You can change the status of a mortgage 
insurance quote and ‘lock it’, which disables 
mortgage insurance quote values from changing 
automatically when there are other loan 
data changes, such as the purchase price. 

Note: This functionality does not ‘final value’ the mortgage insurance quote amounts 
or prevent end-users from making changes.
1.	 Open the Mortgage Insurance Edit screen.
2.	 Click the ‘open’ padlock icon button  on the toolbar.

Note: Alternatively you can click Lock Mortgage Insurance on the Tools menu.
When this occurs, the mortgage insurance quote status changes to ‘locked’, 
which is represented with a ‘closed’ padlock icon button  on the toolbar.

3.	  To switch the lock status, click the padlock icon again.
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Mortgage Insurance Certificate Tasks

Accessing the Interface MI Certificate Request (Export)
The Export to Radian screen is used 
to request a mortgage insurance 
certificate.

Path: Loan Overview > Interfaces > 
Mortgage Insurance

To access the Export screen 
for Radian:
1.	 Create new loan or open an 

existing one.
2.	 On the Interfaces menu, click 

Mortgage Insurance.
3.	 On the Vendor menu, click Radian.

Request Tab
This tab displays a summary of the current loan’s mortgage insurance information 
(if applicable) and is used to enter specific request data for a mortgage insurance certificate 
from the vendor (either a new one or reissue of an existing one)

The following table describes the main sections of the tab:

Section Description

Current This section displays the loan’s current mortgage insurance information as it 
appears on the Mortgage Data screen.
Note: You cannot change the values in these fields.

Request This section contains a list of data fields that are required for a user to complete 
in order to request a mortgage insurance certificate. The selected  request values  
can be changed from the original price quote.

Tip: Click on a field to view descriptive help text at the bottom of the screen.

Existing Certificate This section displays the current MI certificate number (if applicable) and specifies 
if the MI certificate request is a reissue.
Note: An existing certificate number and master policy number are required when 
submitting a reissue request.

Response Tab
This tab displays a summary of the current loan’s mortgage insurance certificate request 
made on the Request tab. When a response is received, the tab fields are updated with 
returned results.

Note: Request status information is updated from the interface vendor approximately every 
30 seconds, until a final decision is made (with or without a mortgage insurance certificate).
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Requesting a Mortgage Insurance Certificate
To submit a request for mortgage insurance certificate:
1.	 Complete or enter all data fields in the Request section of the Request tab.

Tip: Click on a field to view descriptive help text at the bottom of the window.
Note: ‘Split Fee Type’ is a setting specific to Radian; it appears as ‘Rate Plan Type’ 
for most other mortgage insurance vendors.

2.	 Verify that the data check status is ‘green’ or perform a data check to view and correct 
aren’t any data validation failures.

3.	 Click the Send Mortgage Insurance Certificate Request button at the bottom of 
the screen.
The request is sent to the interface vendor and a dialog box appears with information on 
importing the results. The loan’s Conversation Log is also updated with the request action.
Note: Once the results are returned, the Existing Certificate section fields are completed.

Requesting a Mortgage Insurance Certificate Reissue
To submit a reissue request for mortgage insurance certificate:
1.	 Complete or enter all data fields on the Request tab.
2.	 Verify that the data check status is ‘green’ or perform a data check to view and correct 

aren’t any data validation failures.
3.	 Complete the following fields:

•	 Certificate Number
•	 Master Policy Number
Tip: Click on a field to view a help text description.

4.	 Select the Reissue check box.

5.	 Click the Send Mortgage Insurance Certificate Request button at the bottom 
of the screen.
The reissue request is sent to the interface vendor using the entered data. 

Reviewing MI Certificate Response
To view the request status:
1.	 Click the Response tab.

The current certificate status is updated on this tab after the request results have been 
returned to the LOS. After the results are returned, the Certificate Number field on the 
Response tab is updated and the certificate print form is added to the loan record.

Tip: Click Update Status Now to view an updated status if the response has not 
been returned.

2.	 Save the changes and close the screen when you are finished viewing the response.
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Importing Mortgage Insurance Certificate
To import mortgage insurance certificate response results:
1.	 Close or exit the MI Export screen, if it is open.
2.	 Click the Import button  on the Loan Overview toolbar.

This imports the mortgage insurance certificate response to the loan record and displays 
an Information dialog.

Viewing Mortgage Insurance Certificate
To view an imported mortgage insurance certificate:
1.	 Open the Print Form List 

from the Loan Overview.
2.	 Locate the Radian 

Mortgage Insurance 
Report (ID: 4487)

3.	 Select and then double-click to open and view the document.



Radian MI 
Mortgage Director 
LOS Interface  
User Guide

13 User Guide | Radian Mortgage Insurance Mortgage Director LOS Interface Administrator / User Guide

Revised: 
April 22, 2021

Interface Request Responses

A Conversation Log entry is made to the loan record when certain activities occur in the LOS, 
such as sending a request or importing results (after receiving results from a request). This 
log entry reports whether the import was successful or unsuccessful, including additional 
information such as any data check warnings or import response errors.

In the unlikely situation where there is an issue with an interface response, you can also view 
interface Conversation Log entries or the interface response file to help troubleshoot with an 
LOS administrator.

Conversation Log

Successful Import Sample

Interface Response File
Path: Loan Overview > Interfaces (menu) > Interface Files > View Last Radian File
Interface Response File Sample

Radian Support
Assistance with Radian technical issues should be directed to Customer Care at 877.Radian1 
(723.4261).
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